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ELECTRONIC ARTS PRESENTS 

CD-ROM CLASSICS 
NOCTROPOLIS™ 

EPILEPSY WARNING 
PLEASE READ BEFORE USING THIS GAME OR ALLOWING 
YOUR CHILDREN TO USE IT. 
Some people are susceptible ro epilepric seizures or loss of consciousness when exposed to certain 
flashing lights or light patterns in everyday life. Such people may have a seizure while watching 
television images or playing certain games. This may happen even if the per on ha no medical history 
of epilepsy or has never had any epileptic seizures. 
lf you or anyone in your family has ever had symptoms related to epilepsy (seizures or loss of 
consciousness) when expo ed to fl ashing lights, consult your docror prior ro playing. 
We advise that parents should monitor the use of games by their children. lf you or your child 
experience any of the fo llowing symptoms: dizziness, blurred vision, eye or muscle twitches, loss of 
consciousness, disorientation, any involuntary movement or convulsion, while playing the game, 
CMMEDIATELY discontinue use and consult your doctor. 

PRECAUTIONS TO TAKE DURING USE 

Do not stand too close to the screen. Sit a good di stance away from the screen, as 
far away as the length of the cable allows. 

Preferably play the game on a small screen . 

Avoid play ing if you are tired or have not had much sleep. 

Make sure that the room in which you are playing is well lit. 

Rest for at least 10 to 15 minutes per hour while playing a game. 



This document contains all the information that you 
will need to get this game up and running. There are 
important sections covering how to produce the 
necessary boot disk, how to install and run your game, 
a full key guide and instructions on how to use the 
Adobe Acrobat on-line document reader. 

For further information, the original manuals are 
provided "on-line" on the CD. These can be read 
using the included Adobe Acrobat on-line document 
reader. To use this, see the section "Using the On
Line Documentation". 
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System Requirements 

Computer. Noctropo/is requires a1 least an IBM 386/33 or 100% compatible system, and MS
DOS version 5.0 or higher. 
Video Card . YESA - compliant SYGA (640x480 or 640x400). 
Mouse. Noctropo/is requires a Microsof1 o r 100% compatible mouse u ing Microsofl software 
dri ver version 7.0 or higher. 
Memory. Noctropo/is uses SOOK conventiona l RAM (base memory) and e ither extended 
memory (XMS) or expanded memory (EMS). You must have a mini mum of 4 megabytes of 
RAM insta lled in your machine. 

Installation 
Note: If you are ri11111i11g a disk cache such as SMARTDrive prior to i11stalli11g, you 11eed to disable it to 

insure a clean i11slallatio11 . Refer to your disk cache docu111e11tatio11 or make a system boot disk as 
described in Optimising Your System to disable this cache. This only affects tile i11stallatio11 of tile 
game. Wit/I write-be/I ind cac/li11g disabled, SMARTDrive will work 11ormally during gameplay. 

1. Turn on your computer and wa it for the DOS prompt. Some machines boot directly to 

Windows, or a different she ll environment. Be sure to ex i1 Windows (or other shell program) . 
2. insert the CD di k fo r Noctropolis into your CD-ROM drive. 

3. Go to your CD-ROM drive (usuall y D:) by typi ng d: il ENTER I. 

4. Type install and press EN R . 
5. When prompted, fo llow the install ation program. 

6. Go to the drive the game i installed on (usuall y C) by typing c: IJ ENTER ~ . 

7. Type cd\noctrop ENTER to change to the Noctropolis directory. 

8. Run Noctropolis by typing dark ii ENTER JI . 
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Changing Your Sound Card Configuration 
If you ever add a sound card (or change from one ound card lo another), you must reconfigure 
the ound card configuration for Noctropolis. Doing so will not harm your aved games. 

Return 10 the drive and directory where you installed the game (the default is c:\Nocraor) and 

type install ENTE . Follow the prompts 10 change sound card setting . 

Note: Tlru11derboard sou11d cards may experience difficulties w/re11 accessing multiple sounds. 

If You Have Trouble Installing 
lf you have not already, please review the System Requirements for Noctropolis 10 be sure your 
hardware setup and Noctropolis are compatible. 

Memory. To find out how much DOS, XMS and EMS memory your computer has avai lable: 

type mem NTE from the DOS prompt. 

When the memory information is displayed on the screen, look fo r the fo llowing listings: 

Largest Executable Program Size - this number indicates how much conventional DOS 
memory is avai lable. You must have at least Sl2,000 bytes (SOO K) listed here. 

Free Extended (XMS) - this is the amount of extended memory in your computer. You must 
have at least 3, 14S,728 bytes (3072K) li sted here. 

Free Expanded (EMS) - this is the amount of expanded memory configured for your 
system. You must have at lea t 3072K EMS memory. 

If Installation Fails 
Ln the unlikely event that the installation fai ls, an error message should te ll you the nature of 
the problem. See Troubleshooting for so lutions to some common problems. 
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Memory Requirements 
Noctropolis can use three forms of memory: conventional RAM (base memory), extended 
memory (XMS) and expanded memory (EMS). As long as you have at least SOOK of 
conventional memory, and at least 3072K free EMS, the game will run correctly. Lf you are 
unsure about any details regarding the different types of memory, consult you r DOS manual . 

Optimising Your System 
lf you are experiencing problems running Noc1ropolis or you do not have the appropriate 
amount of memory avai lable, it might help to create a separate boot disk and decrease the 
number of memory resident programs (TSRs) you have loaded. 

Do not delete your AUTOEXEC.BAT or CONFIG.SYS files. Without them, your 
computer will not function. 

Using the On-Line Documentation 
If you /rave Microsoft" Windows~ or Wi11dows 95 installed, we reco111111e11d rlrat you install tire Windows 
version of tire Adobe Acrobat reader for greater ease of use when reading tire on-line manuals. See below 
for instructions on i11stalli11g Acrobat for Windows. If you /rave already i11stalled tire Acrobat reader from 
a11otlrer CD-ROM Classics title, it does not need to be re-installed, skip to tire To Start Adobe Acrobat for 
DOS or To Start Adobe Acrobat for Windows section. 

DOS USERS: 

System requirements for DOS: 
386 or 486 based PC (486 recommended) 

DOS S.0 or higher 

2 MB of ava il able RAM (4 MB or more recommended) 

4 MB hard disk space 

Microsoft-compatible mouse 

VGA graph ics card 

Postscript or LaserJet printer supponed 
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To install the DOS Adobe Acrobat on-line document reader: 

I. insert the CD in your CD drive. 
2 Type D: (or the letter of your CD drive, if different) and press Ii ENTER ! to move to the CD drive. 
3. When you see the "D:" prompt, type ADOBE\ACRODOS\INSTALL and press !ENTER !. 
4. Follow the menu prompts to install the on-line documentation reader. 
To start Adobe Acrobat for DOS: 
I. The CD must be in the drive to run the program. 

2. Move to the directory where Adobe Acrobat is installed. By default. it is installed in 
C:\ACRODOS , so you would type: 

c:~ 
co\ACRODOS ENTER 

3. Type ACROBAT ![ ENTER ! to start the program. 
To open an on-line document file: 

Select Open from the File menu. (The on- line documents are located on the CD-ROM 
Classics CD.) 

Double-click on the D: (or appropriate CD drive letter) from the DRIVE dialog box. 

Double-click on the language that you require. 

Double-click on an on-line documentation file to open it. 

To learn how to use Adobe Acrobat: 
Open the file HELPREAD.PDF in the C:\ACRODOS directory on your hard drive. Complete 
Acrobat instructions are contained in thi s file. 

WINDOWS 95 USERS: 
To install Adobe Acrobat for Windows: 

I. From within Windows 95, lnse1t the CD in yo ur CD drive. The CD must be in the drive to 
install and run the program. 

2. Click on the START button, and select RUN ... 
3. Type d:\adobe\acrowin\acroread.exe (If your CD-ROM isn't drive D:. substitute the 

appropriate letter for ·'D".) 

4. Click OK or press ![ ENTER ! and follow the instructions on your screen. 
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To start Adobe Acrobat for Windows: 
I. Stan Windows and ensure that the CD is in t\Je drive. 

2. If the Acrobat Reader 2.0 icon i not visible in the Program Manager window, double
click on the Acrobat program group icon. The Acrobat window opens. 

3. Double-click the Acrobat Reader 2.0 icon. The program begins. 

WINDOWS 3.lX USERS: 
System requirements for Windows: 

386-or 486-based PC (486 recommended) 

4MBRAM 

Microsoft Windows 3. I or greater 
To install Adobe Acrobat for Windows: 
I. lnsert the CD in your CD drive. The CD must be in the drive to instal l and run the 

program. 

2. Stan Windows. 

3. From the Windows Program Manager, choose RUN ... from the File menu. The Run dialog 
box appears. 

4. Type d:\adobe\acrowin\acroread.exe (If your CD-ROM isn ' t drive D:. substitute the 
appropriate letter for "D" .) 

5. Click OK or press E E and follow the instructions on your screen. 

To start Adobe Acrobat for Windows: 
I. Start Windows and ensure that the CD is in the drive. 

2. If the Acrobat Reader 2.0 icon is not visible in the Program Manager window, double
click on the Acrobat program group icon. The Acrobat window opens. 

3. Double-click the Acrobat Reader 2.0 icon. The program begins. 
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To open an on-line document file: 
Select Open from the File menu. (The on-line documents are located on the CD-ROM 
Classics CD.) 

Double-click on the D: (or appropriate CD drive letter) from the DRJVE dialog box. 

Double-dick on the language that you require. 

Double-dick on an on-line documentation file to open it. 
To learn how to use Adobe Acrobat: 

Open the file HELP _R.PDF in the C:\ACROREAD\HELP directory on your hard drive. 

Complete Acrobat instructions are contained in this file. 

To print a document file: 
Select Print from the File menu. Choose the range you want to print from the Print Range 
dialogue box 

If you receive a "Acrobat does not support printing at this device resolution" message, 
increase the resolution in the Print Quality dialogue box 

In DOS, prior to printing, go into Print Setup from the File menu. Choose Bitmap, which 
will provide a list of available printer devices 

The Adobe Acrobat Document Reader does not support 9-pin printers 
Quick Acrobat Tips 

If you have difficulty viewing documents. click on the magnifying glass icon on the bottom of 
the screen to mcrease resolution 

Each document file contains bookmarks that function as an electronic table of contents. To view 
bookmarks, select Bookmarks and Page from the View menu. The bookmarks appear 10 the left 
of the document window 

To jump to the page associated with a bookmark. double-click on the Page icon next to the 
bookmark 

To show or hide any subordinate bookmarks, click the triangle to the left of the bookmark 
To move through the document one page at a time, chck the previous or next page buttons or 

press the B I B cursor keys 

To move through a document one screen at a ume. click above or below the scroll box in the 

scroll bar or press the ~A™1 keys 
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Creating a Boot Disk 
Before creating a boot disk, we recommend that you make a paper copy of your hard drive 's 
config.sys and autoexec.bat start-up files. Type at the DOS prompt: type config.sys ll ENTER ! 
Either hand-copy or, if you have a printer, use to generate a printout of this startup file. 
Now, at the DOS prompt type: type autoexec.bat 

Hand copy or use~ to generate a printout of this stanup file. 

To create a separate boot disk, insert a blank high density disk in your A: drive. (Your computer 
will not boot from the B: drive.) From the DOS prompt, type: format a: /s ll ENTER i 

Modifying CONFIG.SYS 
When the DOS prompt returns and the format is complete, type: edit a: \config.sys !ENTER ! 

When the new screen appears, determine which memory management system you are using (if 
any) from those listed below and type the commands shown under that system: 

CONFIG.SYS using Microsoft's HIMEM.SYS (XMS with DOS 5.0 and up)-the 
Recommended Configuration! 

DEVICE=C:\oOS\JiiMEM.SYS 
DOS=lllGH 
FILES=25 
BUFFERS=25 
SHELL=c :\oos\coMMA D.COM c:\oos /P 
DEVICE=C:\<place your sound lines here> 

Type in the infonnation for your sound card exactly a it appears on the printout of your 
con fig.sys file. It should come from the sound card directory, e.g. c:\5B 16\oRv'lcrMMSYS.SYS. 

DEVICE=c:\<path>\<your CD-ROM driver> <parameters> 

Type in the infomiation for your CD-ROM driver line from the printout of the config.sys. It 
will usually be a line containing the driver name (example: seco.svs) fo llowed by the device 
name of your CD ROM (example: /D:MscoOO I). 

Include the next line only if you have Double Space loaded on your system. 

DEVICE=C:\ooS\oBLSPACE.SYS /MOVE 

Include the next line only if you have Drive Space loaded on your system 

DEV ICE=c:\oos\oRVSPACE.SYS /MOVE 
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CON FIG.SYS using Microsoft's EMM386.EXE (EMS with DOS 5.0 a11d 11p) 
DEVICE=C:\oos\HJMSM.SYS 
DEVICE=C:\oos\EMM386.EXE 3072 RAM l=B000-B7FF 
DOS=HIGH,UMB 
FILES=25 
BUFFERS=25 
SHELL=C:\oos\£:OMMAND.COM c:\oos \p 

DEVICE=C:\<place your sound line here> 

Type in the information for your sound card exactly as i t appears on the printout of your 
config.sys file. It should come from the sound card directory, e.g. c:\ss 16\oRV\crMMSYS.SYS. 

DEVICEHlGH=c:\<path>\<your CD-ROM driver> <parameters> 

Type in the information for you CD -ROM driver line from the printout of the config.sys. It 
wi ll usually be a line containing the driver name (example: ssco.svs) fo llowed by the device 
name of your CD ROM (example: /D:MscoOO I). 

include the next line only if you have Double Space loaded on your system. 

DEVICEHIGH=C:\ooS\oBLSPACE.SYS /MOVE 

Include the next line only if you have Drive Space loaded on your system 

DEVICEHIGH=C:\oos\oRVSPACE.SYS /MOVE 

Exiting CONFJG.SYS 

After typing these lines, you should ex it and save your file. Do so by pre sing: 

AL I[] 
l1Xl 

Modifying AUTOEXEC.BAI 

Next you need an autoexec.bat fi le on your boot disk. Type: edit a:\autoexec.bat !ENTER I 

When the new screen appears, type: 
PROMPT $P$G 
PATH=C:\oos 
SET COMSPEC=c:\oos\£:0MMAND.COM 
c: 
LH c:\<path>\<your mouse driver> 

LO 

Copy your mou e line exactly a it appears in your autoexec.bat printout. It should contain the 

word mouse somewhere in the line (e.g. c :\MousE\MousE). 

c:\oos\MscoEX.EXE <parameter > 

Type in the information for the above MSCDEX.EXE line from the printout of your 
autoexec.bat. This line should be identical except for two items: delete the /E parameter (the 

e and so on - but not past the next pace), and change /M:## to /M:S. For example, 

c:\oos\MSCDEX.EXE /E /M: 15 

wou ld change to: 

c:\oos\MSCDEX.EXE /M:S 

<load sound lines here> 

Copy your SET BLASTER, SET sou •o, and other sound drivers exactl y as they appear in your 
autoexec.bat printout. The other sound drivers should contain the name of your sound card 

directory (e.g. c:\MAGICS20\sNDINIT /B). 

The autoexec.bat fi le does not vary with different memory drivers. 

Exi1 and ave thi s file by press ing: 

~m 
x 
~ 

To Use Your New Boot Disk 
Restart your computer with your new boot disk in yow· A: drive. Type: 

c: EN R (or the drive in which you installed the game), cd noctrop ll ENTER ! (or the directory 

in which you installed the game), dark ~-

' 
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Troubleshooting 
Common Questions 
Q: I get an error message abort/ a VESA driver. Wiien i ioad UNI VBE.EXE, like it told me to, my system 

locked 11p witll a blinking c11rsor. Now what's wrong? 

A: Your card may not suppon the VESA standard. Contact the manufacturer of your video card to obtain a 
current version of the VESA driver for your card. 

Q: Tiie game says it has trouble finding tile INSTA LL.CFGfile. Wlw t should I do? 

A: An error may have occurred during installation. This may be solved by installing with a boot disk. Refer 
to Creating a Boot Disk. 

A: If this occurred whi le reconfiguring your sound card setup. make sure you didn' t type insta ll from your 
CD ROM drive (see Clla11gi11g Your Sound Cord Configurotion). 

Q: My game says PROGRAM TERMINATED NORMA LLY after I installed, or wllen I exit the game. Is 
this bad? 

A: Nope. It just means Lhat your system was working fine when you exited to DOS. 

Q: My mouse is not working with Noctropolis. My mouse works witll all of my other soft ware 
applications. Wiiy not witll Noctropolis? 

A: You should first check to see if your mouse has been loaded in the a utoexec.ba t or config.sys file you 
are booting with (e.g. the boot disk, or hard drive if you are not using a boot disk). If not, it cannot 
interact with your game. and you need to load the mouse driver (see Creating o Boot Disk). Window' 
and many other "multi-tasking" shell environments load their own built-in mouse driver. These mouse 
drivers will not operate outside their she ll environment. Loading a mouse driver into the DOS 

environment can be as simple a typing at Lhe command prompt (c:\>): mouse~ 

A: Your mouse may not be 100% Microsoft compatible. 

If you have the disks fo r Windows 3.1, you can expand the mouse driver. Check each disk's directory (by 
typing DIR MOUSE*) to fi nd something similar Lo MOUSE.CO_ - a few lellers difference is okay. but 
remember to type the fi le name Lhe way it appears in the directory in the fo llowing steps. Copy it to your 
NOCTROP di rectory. Then type expand c:\noctrop\mouse.co_ c:lnoctroplmouse.com. Last ly, add the line 
c:\NOCTRo?\MousE.COM to your autoexec.bat and type REM at the beginning of your previous mouse li ne. 

Q: I have a /00% compatible sou11d card, but I 'm not getting any sound. Wiiy not? 

or 

Q: Noctropolis says that it cannot find my sound card or tllat tile sound initialisation failed. What 's 
wrong? 
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A: If your sound card is not one of the cards listed on the box or in the installation program, but is " I 00% 
compatible" with one of the cards listed, it may have to be put into "SB" (Sound Blaster) emulation 
mode through its software or a switch setting on the card. Consult your sound card manual or its 
manufacturer. 

Q: Wiiy does tire game crash right after tile EA logo? 

A: It may be that the interrupt for the sound board is set incorrectly. ew Sound Blaster cards typically have 
interrupt 5 as the default selling. but older Sound Blasters have interrupt 7 as the default setting. After 
checking the settings of your ~oundboard , re-install sound (see Changing Your Sound Card 
Co11fig11rario11) and select the correct interrupt. 

A: Your card may not support the VESA standard. Contact the manufacturer of your video card to obtain a 
current version of the VESA driver for your card. 

Q: Every time I play, it quits to DOS with an error tllat says I do not lla ve enough memory. 

A: This indicates Lhat not enough memory is available to continue game play. Make sure that you have 
enough free memory in conventional/base RAM and extended or expanded memory (XMS or EMS). Use 
the DOS Mem command to determine how much free memory you have available. There must be at least 
SOOK conventional and 3072K XMS or EMS. Refer to Optimising Your System. 

Q: Noctropolis runs slowly and occasio11ally locks up. 

A: You may be loading other software that is not compatible with Nocrropolis. First, try running the game 
from a boot disk. Refer to Creating a Boot Disk. Also, you may not be meeting all of the necessary 
system requirements. Refer to System Requirements at the beginning of this guide. Also. if you are not 
running SMARTDrive you may want to add that line to your autoexec.ba t file (see Disk Cache Setup). 

Q: Why does my game crash wllen I play Noctropolis through Microsoft Wi11dows or Windows NT, IBM 
OS/2 or Desqview? 

A: Multi-tasking environments such as these often conflict with Noctropolis in their use of memory and 
other system resources. We do not recommend playing Noctropolis under any of these circumstances. In 
general, we recommend that you exit out of Window (or si mi lar applications) and play from the DOS 
prompt. 

Q: Noc/ropolis still doesn 't work after I made a boot disk and/or modified my CON FIG.SYS and 

AUTOEXEC.BAT files. 

A: Copy down the error code and information the computer displayed when it quit to DOS. Then see 

ORIGIN Product Support. 
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Mouse Setup 
Be sure that you are using a I 00% Microsoft-compatible mouse driver - a Microsoft version 7.0 or 
higher mouse driver is preferable. If you are using a boot disk. this driver must be loaded within your 
boot disk configuration. Since the command line may differ from mouse to mouse, consult your hard 
drive 's AUTOEXEC.BAT by typing at the DOS prompt: type c:\autoexec.bat. Look for your mou e 
driver line and copy it into your boot di sk 's autoexec.bat, replacing the previous mouse driver line. 

Consu lt your mouse user"s guide for more detailed instructions on loading the mouse driver for your 
computer. 

Disk Cache Setup 
Before installing Noctropolis, we recommend that you temporarily di sable your disk cache. 
Occas ionally, installing with a disk cache active can generate ' fa lse· bad disk errors. To temporarily 
disable your disk cache program, make a boot disk with one of our recommended configuration . 
(Refer to Creating a Boot Disk for how to create such a boot disk.) Now reboot your computer with 
this boot disk (which does not include the di k cache). When you have completed the in tallation, 
follow the instructions be low to reconfigure your boot disk 10 include the di sk cache program. 

If you decide to install SMARTDrive (a disk caching program), we recommend using the 
SMARTDrive versions from Windows 3. 1 or DOS 6.0. You will need to add the following line to the 
beginn ing of your autoexec.bat fi le 10 insta ll SMARTDrive. (You may need to change the path on 
this line depending upon where your disk cache program i located.) 

Machines with 8 megabytes or more RAM: 
LH c:\oos\sMARTDRV.EXE 2048 c (the fi nal letter being the drive where you insta lled Noctropo/is). 

Nole: On a 4-megabyte machine, a disk cache program will take up too much memory fo r Noctropo/is to 
mn. Though other disk cache programs may work with Noctropo/is, we cannot guarantee their 
compatibility with this software. 
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General MIDI 
Noctropolis only supports General MIDI at port address 330. 

Noctropolis has joined the next generation of music quality with its support of the General MIDI 
standard as defined by the MPU-40 I instruction set. At the time of publishing, only a few cards 
support MPU-40 I . These cards include the Roland SCC- 1, Roland RAP- I 0, Creative Labs Sound 
Blaster 16 with the attached Wave Blaster daughterboard. the Creative Labs Sound Bia ter ASP 16 
with the attached Wave Blaster daughterboard, and the En oniq Sound cape. Other manufacturers 
have already released, or are planning to release, sound cards that utili se the MPU-40 I instruction set. 
However, sound cards that use a memory- res ident program (TSR) to emu late MPU-401 may not work 
with this oftware. 
Note: Some General MIDI sound cards offer digitised speech or sound effect capabilities. However, in lite 

case of the Roland RAP-10, customers will need to use a second sound card such as a Sound 
Blaste~ Sound Blaster Pro or 100% compatible sound card fo r digitised speech and effects. Review 
your s~u11d card docume11tatio11 or contact the manufacturer if you have any questions. 

Technical Support 
If. after thoroughly reviewing ALL the documenta1ion, you are still having a problem with this software. please read 

the following section. 
Electronic Arts has a staff of custo mer service 1echnicians ready to help you wi1h any problems you may encoumer 
with the game. Elecuonic Ans Cus10mer Service is avai lable Monday to Friday during normal business hours on 

(0 1753) 546465. 
Today's PCs nm with millions of different hardware and software combinations. Because of this. you may also have to 
refer to your computer dealer or hardware manufacturer in order to properly configure their product to run with our game. 

When you ca ll , if at all pas ible, be near your computer. If it is not possible. make sure you have the following 

information ready: 

The error message displayed when the problem occurred (if any). 
A listing of your machine type and hardware contents. including CPU. sound and video board details. 

The DOS version number you are currently running. 
Your mouse and driver type. 
The contenis of your CONFIG.SYS and AUTOEXEC.BAT files . 
Your CD-ROM drive type and C D-ROM extensions vers ion, if fitted . 
The contenlS of a C HKDSK and MEM/C statement. 

Or you may write to us al the following address, including the above information. 

Electronic Arts Customer Service. P.O. Box 835. Slough. Berkshire. England SL3 8XU 
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NOTICE 
Electronic Ar1s re5.ervcs the righ t to make improvements in this product described m this manual at any time and without 
notice. 

·1ni!-t manual. and the soflware described in this manual , is under copyright. All riglus arc reserved. No part or lhis manual or 
the described software may be copied, reproduced. translated or reduced to any electronic medium or machine·readablc fonn 
without the prior wriucn consem of Electronic Arts Limited. P.O. BOX 835. Slough. Berks SL3 8XU. England. 

Electronic Arts makes no warranties. condi tions or represcn1ations express or implied. with respect to this manual . its quality. 
merchantability or fitn~s for any particular purpose. 111is manual is provided '"as is". Electronic Arts makes certain limited 
warran1ics with respect to the sofl warc and the media for the software. In no even! sh:ill Elcclronic Arts be liable for nny 
speciaJ. indirccl or consequential damages. 

The~ tenns and condi lions do not affect or prejudice the sla1u1ory rights of a purchaser in any case where a purchaser 1!-t a 
consumer acquiring goods o therwise than in the cour;e of a business. 

Limited Warranty 
Electronic Arts warmnts to the original purchaser of 1his computer soflware producl that the recording media on which the 
software progr.uns arc recorded wi ll be free from defects in materials and workmanship for 90 days from Lhe date of purcha.!;C. 
During such period dcfecLive media will be replaced if the original product is returned to Electronic Arts at the address on the 
rear of this document . together wi th a dated proof of purchase. a statement describing the defects, the fau lty media and your 
return address. 

TI1is warranty is in addition to, and docs not affect your statutory rights in any way. 

This warranty docs not apply to the software program themselves. which are provided "as is''. nor docs it apply 10 media which 
has been subject to misuse, damage or excessive wear. 

N.8. Media Replacement Notice 
Electronic Arts a.re NOT able to replace damaged media once the 90-day limited warranty has expired. This notice supcrcedes 
the Media Replacement Notice on the on-line documentation. 

Nocrropolis is a trademark of Electronic Arts. © 1994 Electronic Arts and Flashpoinl Creative. Electronic Arts is a registered 
trademark of Electronic Arts. Software and documenlation © 1995 Eleclronic Arts. All rights reserved. 

EJ02SCEY 
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